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Acknowledgement 
of country

We acknowledge Aboriginal and Torres Strait 
Islander peoples and their continuing connection 
to land and as custodians of stories for millennia. 
We respectfully acknowledge the land on which 

we all meet today, and pay our respects to elders 
past, present and emerging.



• Check in and get set up on a 

computer

• Check your SLQ account details, as 

it may be required during the 

session

• Login to your Adobe account

• Why did you sign up? what are you 

hoping to get out of this workshop?

Welcome



Navigate to The Edge website and check 
out all the available equipment and 
software available for public use:
https://www.slq.qld.gov.au/visit/spaces/
edge
Come and use the computers and 
software, available during The Edge 
opening hours with a booking for a 
maximum of 4 hours daily.

Intro to The Edge

https://www.slq.qld.gov.au/visit/spaces/edge
https://www.slq.qld.gov.au/visit/spaces/edge
https://www.slq.qld.gov.au/visit/spaces/edge


• Photoshop Interface Overview
• Basic Tools and Shortcuts
• Understanding Layers
• Simple Edits and Adjustments
• Introduction to Selections and Masks 
• Applying Filters and Effects
• Final Project: Create a Simple 

Composition Collage with 
Queenslander Cover

• Review and Group Feedback 
• Wrap-Up and Q&A

Workshop Overview



Health & Safety

For all workshops at The Edge we 

like to familiarise participants with:

• Exit points

• DML Risk Assessments

• Safe operating procedures



• Introduction to The Edge and 
its resources

• Overview of State Library of 
Queensland's Collection

• How you can use Collection 
items for research and 
referencing

• https://onesearch.slq.qld.gov.
au/discovery/search?vid=61SL
Q_INST:SLQ

The Edge - SLQ Collection

Ein Bild, das Text, Zeichnung, Buch, Poster enthält.

Automatisch generierte Beschreibung

Illustrated  fro nt co ver from The Queenslan der, J anuary 17, 1929, Agnew, Garnet (Garnet Ger ald) 1886-
1951, the State Library of Queensland

https://onesearch.slq.qld.gov.au/discovery/search?vid=61SLQ_INST:SLQ
https://onesearch.slq.qld.gov.au/discovery/search?vid=61SLQ_INST:SLQ
https://onesearch.slq.qld.gov.au/discovery/search?vid=61SLQ_INST:SLQ
https://onesearch.slq.qld.gov.au/discovery/search?vid=61SLQ_INST:SLQ
https://collections.slq.qld.gov.au/viewer/IE1143814


Photoshop Workspace

• Introduction to the Photoshop 
workspace. 

• Explanation of key panels: 
Layers, Tools, and Properties. 

• Demonstration of how to 
navigate menus and tools.



Photoshop Workspace
Navigating the Workspace
Now that we have our files open, let's have a look at our workspace:

The Menu Bar shows the File, Edit, Image, and other menus that give 
you access to a variety of commands, adjustments, and panels.

The Options bar (beneath the menu bar) displays a range of options 
for the tool you are currently working with. When you change tools, the 
options here will change.

The Tools panel (on the left) contains tools for editing images and 
creating artwork. Some tools show a small triangle in the bottom right-
hand corner - this indicates that related tools are hidden underneath 
what is currently shown. To access related tools in a group by clicking 
and holding a tool in the panel.

Panels (on the right) include Color, Layers, Properties, and other 
panels that contain controls for working with images. You can find the 
full list of panels under the Window menu, but today we'll primarily be 
working with 'Layers' and 'Properties'.

The Document Window (in the middle) displays the file you’re 
currently working on. Multiple open documents show up in tabs in the 
Document window. If you want, you can click and drag on a tab to 
separate it, so that you can view more than one document at the same 
time.

Menu Bar 

The Document Window

The Options Bar 

Panels

The Tools Panel



Photoshop Workspace
The menus are located at the top of the interface and house most of the Photoshop functions 
within them. Most of the commonly used functions can also be accessed via shortcuts as well. 

• File: This menu houses various functions like creating, opening, saving, exporting files as well 
as exiting the program and bridging with other adobe software. 

• Edit: The Edit Menu houses functions that allow you to cut, copy, past, transform content and 
undo actions as well as customise certain settings of Photoshop itself. 

• Image: This menu allows you to make changes to the image and canvas properties like size and 
resolution. It will also let you adjust the colour mode of the whole file. 

• Layer: This menu houses all the options that involve layers. You can add, rename, duplicate, 
merge, delete layers within this menu as well as more relevant functions. 

• Type: This menu will allow the manipulation of text-based content in Photoshop and is 
generally greyed out unless you are working on a text layer. 

• Select: This is the menu that has the functions to control and create selections. Most of the 
functions like growing, shrinking, feathering or refining selections will be greyed out until a 
selection is made. 



Photoshop Workspace
• Filter: This menu houses all the various built-in filters that Photoshop already has as 

well as access to the filter gallery. 
• View: This menu will allow you to change how Photoshop elements are displayed. 

Useful functions like zooming in and out or changing screen layouts are housed here 
as well as the options for showing and manipulating rulers, guidelines and grid lines. 

• Window: The window menu houses the check list for all the toolbars you can have 
visible on the Photoshop interface. If the layers window or Tools windows seems to be 
had been toggled off, this is where you can you find them. 

• Help: This is the menu that houses all the helpful links that aim to answer Photoshop 
related questions. It also has information on the Photoshop software you are using.



Basic Tools and Shortcuts
• Demonstration of essential tools: 

Move, Selection, Brush, Eraser, and 
Zoom tools.  

• Explanation of shortcuts for 
efficiency. 

• Hands-on practice with guidance.



The Toolbar

Move Tool (V): This tool allows you to move the selection or image around on the current layer. You can also access this tool 

by keeping the ctrl/command key pressed (will revert back to original tool after button release).

Marque Selection Tools (M): This is one of the tools to make selections. You can choose the shape of the selector.

Lasso Tool (L): This is another tool for making selections.

Brush Tool (B): This tool allows you to paint using different brush shapes. Also check the options bar for opacity, flow 

and brush shape options. You can bring up the brush options by right clicking on the screen while having the brush tool 

selected. This is also the place for importing new brushes.

The toolbar is where all the tools live. The most common ones are brushes, eraser, selections, paint bucket and text 
tools. You can select them by left clicking on the buttons that represent what they do. Some tools also have a little 
triangle at the bottom left of their icon which means you will get extra tools if you left click and hold the button down 
while selecting them. Below are the explanations of a few commonly used tools with their shortcuts within brackets.



The Toolbar – Continued 
Eraser (E): This tool works just like the brush tool, but instead of colouring in, it will erase images in 

accordance with the shape of the brush selected. The different shapes can be accessed the same 
way as brushes, right click while having the eraser tool selected.

Paint Bucket (G): This tool allows you to fill up entire layers or selections with a certain colour or 
pattern.

Text Tool (T): This tool allows you to create text on your imagery. The text will be created on a separate 
vector layer by default. Needs to be rasterized before you can edit it certain Photoshop features. To 
do this, right click the layer and click Rasterize Type.

Hand Tool (H): This tool will allow you to move around your image if you are zoomed in too much or it 
is too big for the screen. You can also select this tool by keeping the spacebar held down (will revert 
back to original tool on spacebar release).

Zoom (Z): This is the tool that allows you to zoom in and out. It is set to zoom in by default but you can 
toggle zoom out by holding down the alt key.

Colour Boxes: These are at the bottom of the toolbar and will depict what colours you will paint with. 
You can change them by clicking on the boxes. IMPORTANT: Right clicking on the screen will bring



Basic Tools and Shortcuts

For a full list of all available shortcuts and customisation options check out the following website:
https://helpx.adobe.com/au/photoshop/using/default-keyboard-shortcuts.html

Result Windows macOS

Start Help F1 Help key

Undo/Redo F1

Cut F2 F2

Copy F3 F3

Paste F4 F4

Switch to Zoom In Control + spacebar Command + spacebar

Switch to Zoom Out Alt + spacebar Option + spacebar

Here is the most popular shortcuts for both Windows and macOS

https://helpx.adobe.com/au/photoshop/using/default-keyboard-shortcuts.html
https://helpx.adobe.com/au/photoshop/using/default-keyboard-shortcuts.html
https://helpx.adobe.com/au/photoshop/using/default-keyboard-shortcuts.html
https://helpx.adobe.com/au/photoshop/using/default-keyboard-shortcuts.html
https://helpx.adobe.com/au/photoshop/using/default-keyboard-shortcuts.html


Understanding Layers
• Explanation of the importance of 

layers in Photoshop. 
• Demonstration of how to create, 

edit, and organise layers. 
• Hands-on practice: adding images 

to separate layers.



Understanding Layers
• The existence of Layers is one of the core features 

that makes Photoshop as amazing as it is. Layers 
allow for non-destructive editing and offer a range 
of benefits for managing image complexity 
without interfering with what you have already 
create.

• The layers are displayed under the Layer window 
on the interface (if it's not activated, press F7 as a 
shortcut or go to the Windows Menu and click 
Layers so it has a check next to its name).

• IMPORTANT: You should always be aware of the 
layer you are working on. The active layer will be 
highlighted within the layer window.



Understanding Layers
Creating a New Layer: This can be done in a few ways. Layer Menu → New →
Layer (Shortcut: ctrl/command + shift + N) will create a popup where you
can name it and specify some details. You can also do this by clicking the button
resembling a page at the bottom of the layer window.

Reordering Layers: You can left click and drag the Layers within the layer window
to reorder them above each other.

Grouping Layers: You can group layers within a folder as well. This will make
editing easier if a lot of layers are necessary. To create a group, you can go to Layer
Menu → New → Group or click the button that looks like a folder at the bottom
of the layer window. You can then drag layers onto the folder to put them in the
group. Or out of a folder to remove them from it.

Deleting Layers/Groups: You can go to Layer → Delete → Layer/Group to get rid
of them. You can also drag them down to the trash bin at the bottom of the layer
window. Note that there must be at least one layer in any given file, so you cannot
delete the last existing layer or the group containing that layer.



Simple Edits and Adjustments 
• Demonstration of basic photo 

editing: cropping, resizing, and 
color adjustments 
(Brightness/Contrast, 
Saturation, etc.). 

• Hands-on practice: making 
adjustments to the sample 
images.

•



Photoshop has several basic photo editing options to choose from.

Cropping:
• Click on the Crop tool (C) and then you can adjust the box using the handles or arrow keys to crop to your 

desired size and then hit the check mark that appear in the top right of the screen. 
• You can also set specific aspect ratio from the options bar.

Resizing:
• Go to Image > Image size.
• Enter the new width and heigh value, you can choose from pixels, inches or centimeters.
• Or selected from a pre-defined sizes in the "Fit To" drop down.
• Click OK to accept the changes.

Colour Adjustments:
• Use an adjustment layer for non-destructive editing, select this layer type when creating a new layer.

o Levels - Alter the tonal range of an image by moving the sliders.
o Curves – Provide more precise control over the tones of an image via a graph.
o Hue/Saturation -  Modify the colour/intensity of the hues within an image.
o Colour balance - Edit the colour balance of an image, correct colours or balance the colour tone of the 

image.

Simple Edits and Adjustments 



Introduction to 
Selections and Masks
• Explanation of different selection 

tools: Marquee, Lasso, and Quick 
Selection.

• Demonstration of creating masks 
and non-destructive editing. 

• Participants practice selecting and 
masking elements from images.



Introduction to Selections
The selection tool can be found in the toolbar on the left-hand side of the work plane.

• Rectangle marquee tool - Draws square or rectangle borders 
• Elliptical marquee tool –  Draw round or elliptical borders
• Lasso tool - Allows you to draw freehand selections borders
• Polygonal lasso tool - Multiple straight edged segments selection borders
• Magnetic lasso tool - A selection border that automatically snaps to edges when you drag over the 

photo
• Magic wand tool - Selects similar pixels of similar colour
• Quick selection tool - Make selections based on colour and texture when you click or click and 

drag on an area
• Object selection tool - Automatically selecting objects or regions in an image, like people, cars, 

trees, etc



Introduction to  Masks
Using masks and non-destructive editing , these ensure that the 
original pixels of the photo are not changed and allow for easy 
editing.

Masks allow you to conceal or revel different areas of an image.

To create a mask:
• Select a layer and select "Add  Layer Mask" icon at the bottom 

of the layers panel. A white thumbnail will appear.
• Masks use black and white colour areas. Black will hide the 

area while White will reveal the area. You are also able to 
invert this layer to swap the effect of the visible/hidden areas.

• To blend the mask, you can use the blend modes or the 
opacity . Blend modes can be found in the layer panel, some 
of these include Darken, Lighten and Multiply each having a 
different effect.

• More information on adjustment layers and smart 
filters/objects will be explained later.



Applying Filters and Effects
Filters 
• Filters are functions within Photoshop that allow you to manipulate 

your images in very specific ways. 
• Photoshop also has something called Smart filters, which are non-

destructive edits and are applied to Smart Objects. Smart filters will be 
stored in the Layers panel for easy changes to be made.

• Filters can be found under the Filter Menu.
o You can apply a filter to the entire layer, to do this ensure you have 

the full layer selected.
o You can apply a filter to a section by only having this area selected 

using the selection tool.
o Smart filters can only be applied to a Smart object/s that 

are selected.

• Smart Objects:
o Right-click on an image layer in the Layers list and select "Convert 

to Smart Object".
o This option can also be found in the context menu.



Applying Neural filters (AI)

Neural filters use machine learning to quickly and easily change the 
image

• To access neutral filters by clicking on the filters > neutral filters.
• This will open the Neural Filters panel, to view all the available 

filters then select All filters, if a filter as a cloud icon next to it this 
means it will need to be downloaded  before it can be used. Click 
on the icon to download the filter.

• Toggle on your chosen filter.
• Once turned on you can then make adjustments via the options 

panel on the right.
• You can preview the changes from the filters by clicking the 

preview button in the lower left hand.
• You can also reset any applied filters by clicking on the back 

arrow that appears in the options tab. (If you hover over it, it will 
say "Reset parameters".

• Click ok to save the selection or cancel to exit.
• Saving the output as a new layer will allow for further non-

destructive editing or for this example save out as a New Layer 
Masked.



Final Project: Create a Simple Composition 
Collage with Queenslander Cover

• Create  a composite image using the skills learned 
(layers, selections, filters). 



Final Project: Create a Simple Composition 
Collage with Queenslander Cover

• Find Covers:
o Use the State Library catalogue via One Search to find various 

Queenslander magazine covers that you like.
o Download or save the covers you'd like to include in your collage.

• Open in Photoshop:
o Import each selected cover into Photoshop.

• Cut Out Elements:
o Use the Object Selection Tool and Quick Selection Tool to 

select the elements you want from each cover (e.g., images, text, 
illustrations).

o Copy and paste each selected element onto a new A4 
document. This A4 file will become your final collage.

• Refine Your Selections:
o Use the Eraser Tool to clean up rough edges.
o You can also use Select Subject (available at the bottom of the 

workspace) to automatically refine your selection for more 
accurate cut-outs.



Final Project: Create a Simple Composition Collage with Queenslander Cover

To create a background layer, we will use the cover of The 
Queenslander and the Queenslander logo.
• Add the Logo:

• Use the Selection Tool to select and copy the 
Queenslander logo.

• Paste the logo onto your new layer.
• Prepare the Background:

• Select all the foreground subjects on the 
Queenslander cover.

• Delete them using the Content-Aware Fill option. 
This will use AI to automatically fill the removed 
areas with similar textures and colours from the 
surrounding background.

• Finalise the Background:
• Once you're happy with the result, copy the entire 

background layer.
• Paste it into your new document.
• Create a group layer titled "Background" to keep 

your layers organised.



Final Project: Create a Simple Composition Collage with 
Queenslander Cover

• Paste Your Elements:
o In your new A4 document, paste all the cut-out 

pieces from the Queenslander covers.
o Begin arranging them into a composition that feels 

visually balanced and appealing to you.
• Stay Organised:

o Name your layers as you go to keep things tidy and 
manageable.

o You can change the layer order by dragging layers up 
or down in the Layers panel to control which 
elements appear on top.

• Keep Building:
o Continue bringing in more elements and arranging 

them until you're happy with your collage.
• Experiment with Filters:

o Try out different filters and effects to add texture, 
unify your composition, or create a particular mood 
or style.



Final Project: Create a Simple Composition Collage with Queenslander Cover

• Explore Filters:
o Try out the various filters we covered during the 

workshop.
o Adjust Hue/Saturation, or add blur and distortion.
o Use Brush Strokes or Artistic filters from the Filter 

Gallery to give elements a painterly effect.
• Use Neural Filters:

o Experiment with Neural Filters to colourise black-and-
white images.

o Try style transfer effects for a more creative, unique 
look.

• Play with Shapes:
o Use the Shape Tool to create circles, rectangles, or 

custom shapes.
o Fill shapes with colour, layer them, and move them 

around to add interest or enhance your background.
• Refine Your Composition:

o Keep adjusting and moving your elements until you’re 
happy with your final collage.

o Feel free to remove the logo or create a new 
background if it better suits your design.



Saving your project
When saving your images, there are several formats available, from the 
standard Photoshop file format, to a number of other raster image types:
• .psd is the standard Photoshop format. When you save in this file 

format, you can pick up exactly where you left off. This file type can 
only be read by Photoshop.

• .tif is intended for high quality images with minimal loss of image 
data. The file format is typically very large as a result. Primarily used 
for printing.

• .jpg is popular because of its ratio of quality to file size. It uses image 
compression to pack as much information into the smallest file size, 
and you can adjust the level of compression within the save options. 
High quality .jpgs can be used for printing also.

• .png is primarily for screen display. The format also supports 
transparency.

• .gif is primarily used for screen display. The format also supports 
transparency. (You can also create animated gifs in Photoshop too!)

When saving your file/s, consider their intended purpose and pick your 
file type accordingly. It is always recommended that you save a .psd 
version so that you can go back and make changes should you ever want 
to, as all other raster file types will 'flatten' all of your layers into one.



Wrap-Up and Q&A 
• Recap of the session and key takeaways. 
• Tips for further practice and improvement. 
• Q&A and collection of feedback.

Play around and see what you can create!

Check out the SLQ Wiki for some more activities:
• https://wiki.slq.qld.gov.au/doku.php?id=facilities:sl

q_wiki:creating_a_seamless_pattern_in_photoshop
• https://wiki.slq.qld.gov.au/doku.php?id=workshops:

public:photoshop:recolour_vintage_photographs:st
art

https://wiki.slq.qld.gov.au/doku.php?id=facilities:slq_wiki:creating_a_seamless_pattern_in_photoshop
https://wiki.slq.qld.gov.au/doku.php?id=facilities:slq_wiki:creating_a_seamless_pattern_in_photoshop
https://wiki.slq.qld.gov.au/doku.php?id=facilities:slq_wiki:creating_a_seamless_pattern_in_photoshop
https://wiki.slq.qld.gov.au/doku.php?id=workshops:public:photoshop:recolour_vintage_photographs:start
https://wiki.slq.qld.gov.au/doku.php?id=workshops:public:photoshop:recolour_vintage_photographs:start
https://wiki.slq.qld.gov.au/doku.php?id=workshops:public:photoshop:recolour_vintage_photographs:start
https://wiki.slq.qld.gov.au/doku.php?id=workshops:public:photoshop:recolour_vintage_photographs:start


THANKS FOR ATTENDING

Please complete our survey that will be sent out via 
Eventbrite.

Tag us on socials @statelibraryqld

Contact us on appliedcreativity@slq.qld.gov.au

mailto:%20appliedcreativity@slq.qld.gov.au
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